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AMIGA ENHANCER

The AMIGA ENHANCER package includes:

1. New versions (Version 1.2) of the Kickstart, Workbench, and Extras software disks.
The Extras disk includes the new PC Utilities software, which allows you to format
and copy 5% inch disks in MS-DOS format.

2. The Enhancer documentation, which includes:

—Introduction to Amiga Update

—The AmigaDOS Manual Update

— Amiga ROM Kernel Reference Manual Update
— Intuition Amiga System Software Update
—Introduction to PC Utilities

Changes made to the Version 1.2 release to improve system reliability may result in
incompatibility with early releases of some application programs. Contact the develop-
er’s customer support for information on update releases for V1.2. You may encounter
problems with the following programs on V1.2: Music Studio, Deluxe Video (using
sampled sound), Seven Cities of Gold, and Transformer.

Following are summaries of the Enhancer documentation.

Introduction to Amiga Update

This consists of individual sentence or paragraph changes which are keyed to page
numbers in the original document. In some cases the change may be more than a

page long.

Changes occur on the Copyright page at the front of the book; in Chapters 4, 5 and
7; and in Appendix A.




Major new features described in the update pages include:

Page 4-32:

Page 5-2:
Page 5-3, 7-6:
Page 7-5:
Page A4,
56,7, 8

Page A-9:

Page A-22:

Page A-22:

Page A-22:

Page A-22:

Page A-22:

A RAM disk icon that appears when a RAM disk is created by a
program or by using CLIL

A new Expansion drawer on the Workbench.
Additional printers supported.

A new gadget, Change Serial, is used in place of the Baud Rate
Gadget in Preferences.

New notepad features.

New menu shortcuts.

Many new keyboard configurations are available. These can be
defined by using a new Workbench tool called SetMap. Details
on using SetMap (including illustrations of each new keyboard)
are given in this Introduction to Amiga Update.

A new tool, KeyToy, is added to the Extras disk.

New GraphicDump and Say icons have been added to the
Workbench.

New information on printer escape sequences, including a list
of ANSI X3.64 style commands.

Support for both NTSC and PAL video standards.
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The Amiga DOS Manual Update

This consists of individual sentences or paragraphs changes that are keyed to page
numbers in the original document.

Amiga ROM Kernel Reference Manual Update

This consists of individual sentences or paragraphs changes that are keyed to page
numbers in the original document.

Intuition Amiga System Software Update

This describes changes to and makes general observations about the revision to
Intuition that is part of the Version 1.2 Kickstart or ROM software. The discussion is
keyed to topics (screens, windows, gadgets, etc.), rather than to the specific page
numbers of the original documentation.

Introduction to PC Utilities

This describes the tools provided by the PC Utilities software. (Additional details
are available on screen in the form of prompts displayed as the PC Utilities tools are
being used.)
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Introduction to Amiga: Update to Revision D

for
Amiga® System Software Release 1.2

In this section, you'll find changes to revision D of Introduction to Amiga for the 1.2 release
of the Amiga system software.

Copyright page:

Page 4-8:

Page 4-8:

' Amiga is a registered trademark of Commodore-Amiga, Inc.

Amiga Transformer is a trademark of Commodore-Amiga, Inc.
Apple and ImageWriter are trademarks of Apple Computer, Inc.
Epson is a registered trademark of Epson America, Inc.

IBM is a registered trademark of International Business Machines
Corporation.

Okidata is a registered trademark and Microline is a trademark of
Oki America, Inc.

When you drag an icon on the Workbench, you see a copy of the
icon move. The Pointer does not change shape when you drag an
icon.

If you use Extended selection to select more than one icon, you can
drag all the icons you selected at the same time. Hold down the
SHIFT key and select the icons; when you select the final icon, do
not release the Selection button; instead, release the SHIFT key.
You can now move the icons you've selected by moving the mouse.
When you're finished moving the icons, release the Selection but-
ton.




Page 4-15: If you select an icon and then choose Rename from the Workbench
menu, the gadget that appears is automatically selected. You can
change the gadget’s name as soon as the gadget appears. If you click
the Menu button when this gadget is displayed, the gadget is no
longer selected. If this happens, select the gadget by pointing any-
where within the gadget and clicking the Selection button.

Page 4-21: The text before the first two illustrations reads as follows:

Moving Windows in Front of Other Windows

When windows overlap, one window appears in front of the others. To move a
window in front of other windows, select the Front Gadget:

You can also move a window to the front by pointing to the icon you selected to
open the window, then double-clicking the Selection button.

The text before second two illustrations on page 4-21 reads as
follows:

Pushing Windows Behind Other Windows

To move a window behind other windows with which it overlaps, select the Back
Gadget:

Page 4-27: If you drag a screen so that part of it is below the bottom of the
display, the Amiga takes advantage of any extra display area at the
bottom of a monitor and displays as much of the screen as it can.
One result of this is that icons and gadgets in a screen may be visible
at the extreme bottom of the display, but may be lower than the area
you can point to with the Pointer.



Page 4-30:

Page 4-31:

Page 4-30:

Page 4-30:

Autorequest requesters are requesters that contain only two gadgets: a
Retry or Continue Gadget, and a Cancel Gadget. There are Amiga-
key shortcuts for selecting the gadgets in these requesters. To select
Retry or Continue, hold down the left Amiga key, then with the key
still down, press the V key. To select Cancel, hold down the left
Amiga key, then with the key still down, press the B key.

When you initialize a disk, the disk drive light stays on until the
initialization is complete.

Whenever you initialize a disk from the Workbench, a Trashcan icon
appears in the disk drawer for the disk. If the Workbench disk you
used to set up the Workbench (the SYS: disk) is in a disk drive, the
Trashcan icon from that Workbench disk appears on the disk you're
initializing. (If you used the Icon Editor to change the Trashcan icon
on a Workbench disk and you’d like that icon to appear on newly
initialized disks, be sure to use that disk to set up the Workbench.) If
the SYS: disk is not currently in a disk drive, the same Trashcan that
appears on new Workbench disks will appear in the disk drawer of a
newly initialized disk.

Requesters are automatically selected when they appear.

A system requester is a requester that appears when AmigaDOS or
another program needs a response from you. An example is a
requester that asks you to insert a disk.

A system requester can appear in any screen. If the screen contain-
ing a system requester is obscured by another screen, the screen
containing the requester is brought to the front; this ensures that the
requester is visible. When you've replied to the requester, you can
move the screen to the back by selecting the screen’s Back Gadget
(one of the two gadgets at the upper right of the screen). If the
requester appears in the Workbench screen, you can also move the
screen back by holding down the left Amiga key while you press the
M key.




Page 4-32:

Page 4-33:

Page 4-33:

Page 5-2:

Page 5-2:

A RAM disk is an area of the Amiga’s random access memory used
for operations that normally involve disks. When you use the CLI to
create a RAM disk, or when a program you're using creates a RAM
disk for you, an icon for the RAM disk now appears on the Work-
bench. (You cannot create a RAM disk directly from the Workbench.
To learn about RAM disks, see the AmigaDOS Manual published by
Bantam Books.)

Once an icon for a RAM disk appears on the Workbench, it remains
there until you reset or turn off your Amiga.

String Gadgets are gadgets that accept text. An example is the gadget
that appears when you choose Rename from the Workbench menu.
When you select a String Gadget, a Text Cursor appears in the
gadget. If you select a String Gadget that already contains text, you
can point to the place in the text where you want the Text Cursor
to appear.

Programs can select String Gadgets for you. When a String Gadget
appears with a Text Cursor in it, it's selected and you can begin
typing. The gadget is selected until you select another gadget,
requester, or window.

The Expansion drawer on the Workbench is new. To use a new
device, such as a hard disk drive, with your Amiga, you drag the
icon that represents the driver file for the device into the Expansion
drawer. The driver file and its icon are supplied by the manufacturer
of the device.

Interlace screens (described in the notes about Preferences that follow)
appear to “flicker” on many monitors. This flickering can cause
eyestrain and other problems. “Long-persistence’”” monitors are
available that greatly reduce the perceived flicker. These monitors
can be valuable in applications that require interlace screens.



Page 5-3:

Page 5-3:

5Y4" disk drives, such as the Amiga Model 1020 drives used with the
Amiga Transformer™, can be used as external storage devices for
the Amiga. Installation instructions are provided with Model 1020
drives; for other 5%" drives, see your Amiga dealer for the proper
cables and instructions.

When using 5% disks on the Amiga, a system requester may
appear that asks you to insert a disk. The Amiga can detect when
you insert a 32" disk, but it cannot detect when you insert a 5%4"
disk. After you insert a 5%4" disk, you must enter the AmigaDOS
diskchange command followed by the name of the disk drive in
order for the Amiga to recognize the disk.

The Amiga supports four additional dot-matrix printers:
® The Apple™ ImageWriter™ II

® The Okidata® Microline™ 92

® The Okidata® Microline™ 192

® The Okidata® Microline™ 292

The Microline 92 and 192 printers are each available in two versions:
a standard version and a version compatible with IBM® dot-matrix
printers. To use the standard version, select Okidata 92 from the list
of printer choices in Preferences. To use a version compatible with
IBM printers, select CBM_MPS1000 from the list. The Microline 292
printer can be used with two different “personality cards”: one that
makes it compatible with IBM printers and another that, when used
with a different ribbon, lets you print in color. To use the Microline
292 as an IBM compatible printer, select CBM_MPS1000 from the list
of printers in Preferences. To use the Microline 292 as a color
printer, select Epson_JX-80 from the list.




Page 7-2:

Page 7-2:

Page 7-2:

Page 7-3:

Page 7-4:

There are Front and Back Gadgets and Drag Bars in all the Prefer-
ences windows. The Preferences Edit Pointer display is a screen
rather than a window; it lacks the Front and Back Gadgets, and
although it has a Drag Bar, you cannot drag it to a new location.

The date in Preferences is displayed Day/Month/Year.

The clock in Preferences advances when Preferences is open.

There is a Preferences setting called Workbench Interlace. By chang-
ing this setting to On, you double the number of horizontal lines
that make up the Workbench screen. The On and Off Gadgets that
control this setting are at the upper right of the Preferences window.

For a new Workbench Interlace setting to take effect, first save the
setting by selecting the Save Gadget, then reset the Amiga.

On many monitors, the colors in an interlaced screen may appear to
“flicker.” You can often reduce this effect by changing the screen’s
colors. For the Workbench, you can use Preferences to change
the colors. Experiment to find the colors that work best on your
monitor.

For the CLI icon to appear, you must select the On Gadget to the
right of “CLI” in Preferences, then select the Save Gadget to save
the new setting. If the System drawer is closed, open it to see the
icon. If the System drawer is already open when you leave Prefer-
ences, you must close it and reopen it to make the icon appear.



Page 7-5:

In place of the Baud Rate Gadget in Preferences, there is a gadget
labeled Change Serial. When you select this gadget, a new window
appears; in this window are gadgets you use to change settings for
serial communication. You may need to change these settings to
meet the requirements of a particular application or add-on device.
The serial settings are as follows:

® Baud Rate. This is the number of bits transferred through the
serial connector each second. The current rate is shown immedi-
ately below the words Baud Rate; to change it, select either the Up
or Down arrow to the right of the rate.

® Buffer Size. The Serial Buffer is an area of memory set aside for
serial communication. Its size is shown immediately below the
words Buffer Size; to change it, select either the Up or Down
arrow to the right of the size.

® Read Bits. This is the number of bits expected for each character
received through the serial connector. You can select either 7 or
8 bits.

® Write Bits. This is the number of bits that are sent through the
serial connector for each character. As with the Read Bits setting,
you can select either 7 or 8 bits.

® Stop Bits. Stop bits are bits added to the end of a character that
mark where it ends. You can select either 1 or 2; this is the
number of bits added to each character sent through the serial
connector, and the number expected at the end of each character
that is read.

® Parity. Parity checking is a method for reducing transmission
errors. Select Even to specify even parity, Odd for odd parity, or
None for no parity checking.

® Handshaking. This setting lets you specify one of two methods to
control the flow of information through the serial connector. You
can select xON/xOFF, RTS/CTS, or None if you do not need either
method.




Page 7-6:

Page 7-6:

Page 7-7:

Page 7-8:

Page A-4:

When you're through changing these settings, select OK to confirm
your selections or Cancel to cancel them. Selecting either OK or
Cancel returns you to the Preferences window.

There are three new choices in the Preferences printer list:

® ImagewriterlI (for The Apple ImageWriter II)

e Okidata 292 (for the Okidata Microline 292)

e Okidata 92 (for the Okidata Microline 92)

For more information about these and other supported printers, see

the notes for Chapter 5 in this package.

If you add a new printer driver file to the Workbench disk, a new
entry will appear in the Preferences printer list.

The “generic”” selection in the Preferences printer list is the default
selection.

When printing graphics on Epson® and other dot-matrix printers,
narrow blank lines may appear on printouts. If this occurs, selecting
the Custom setting for Paper Size in Preferences may correct the
problem.

When the Clock’s alarm goes off, the window for the Clock appears
in front of all other windows on the Workbench.




There are many new Notepad features and options, which among other things allow
you to do the things described below (see the descriptions that follow for manual pages
A—4 through A-9):

® Set tabs using the keyboard TAB key

Open the Notepad from disk without loading fonts

Change the default location on the screen where the Notepad opens

Change the Notepad’s default font on both an overall and a note by note basis

Move the cursor from line to line and page to page using keyboard commands

Scroll up and down using a Scroll Gadget

Delete, copy and move text using an Edit Menu and the Clipboard

Change the default Print As option from Graphic to Draft

Change the default printer option to Formfeed

Select an Automatic Wordwrap option

All of these features are described below.

Page A-4: When entering text into a Notepad note, pressing the TAB key adds
enough spaces to the left of the Text Cursor to move it to the next
predefined tab stop. The first of the Notepad’s predefined tab stops
is at the eighth character position to the right of the left margin;
additional tabs stops are eight columns apart.

Page A-4: You can open the Notepad without loading fonts from disk as
follows:

1. Select the Notepad icon, choose Info from the Workbench menu,
select the ADD Gadget, and select the ““tool types” string gad-
get—or see Page A-22 and follow that format if you want to be
consistent.




Page A-4:

Page A-4:
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2. Type in “FLAGS =nofonts”, press the RETURN key, and select
the Save Gadget.

If you open the Notepad without loading fonts from disk, you can
choose the new Read Fonts item in the Project menu to read the
fonts into memory.

To specify the size and position of the Notepad window whenever
you open the Notepad follow the steps below:

1. Select the icon for the Notepad or the icon for a note you've
saved, choose Info from the Workbench menu, select the ADD
Gadget, and select the “tool types” string gadget—or see Page
A-22 and follow that format if you want to be consistent.

2. Type in “WINDOW=""followed by (1) a three-digit number
specifying the number of pixels from the left edge of the Work-
bench screen on the left edge of the window, (2) a comma, (3) a
three-digit number specifying the number of pixels from the top
edge of the Workbench screen to the top edge of the window, (4)
a comma, (5) a three-digit number specifying the width of the
window, in pixels, (6) a comma, and (7) a three-digit number
specifying the height of the window, in pixels.

An example: WINDOW =100,070,050,090
3. Press the RETURN KEY and select the SAVE Gadget.

If the Notepad cannot create the window you've specified, it will
ignore your request.

You can also specify the position and size of the window for a note
you've saved by selecting the icon for the note, then performing
steps 2 and 3 listed above.

To specify the default font for Notepad whenever you open the
Notepad follow the steps below:

1. Select the Notepad icon, choose Info from the Workbench menu,
select the ADD Gadget, and select the “tool types” string gad-



Page A-4:

Page A-5:

Page A-5:

Page A-5:

get—or see Page A-22 and follow that format if you want to be
consistent.

2. Type “FONT =" followed by the name of the font (as shown in
the Notepad’s Font menu), a period, and a number for the font
size (for example, FONT = emerald.20) then press the RETURN
key.

3. Select the SAVE Gadget.

There is a limit to the number of lines you can include in a Notepad
note. This limit varies; it depends on the size of the fonts you use for
your note. (With the plain, 9-point Topaz font, the original default
font for the Notepad, you can enter 73 lines.) When you reach the
limit, characters you type no longer appear in the Notepad window.

Holding down the SHIFT key while you press the Up cursor key
moves the Text Cursor to the top of the current Notepad page.
Holding down the SHIFT key while you press the Down cursor key
moves the Text Cursor to the bottom of the current page. Holding
down the SHIFT key while you press the left cursor key moves the
Text Cursor to the beginning of the line. Holding down the SHIFT
key while you press the right cursor key moves the Text Cursor to
the end of the current line.

The page number of whatever page is being displayed appears in
the Notepad’s Previous Page Gadget.

There are Up and Down Scroll Gadgets at the right of the Notepad
window. Selecting the Up Scroll Gadget (the arrow-shaped gadget
immediately below the Previous Page Gadget) moves the text in the
window up one line. Selecting the Down Scroll Gadget (the gadget
immediately above the Sizing Gadget) moves the text in the window
down one line.

11




Page A-5:

Page A-5:
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There is an Edit menu for the Notepad that lets you perform several
text editing functions in the Notepad. To cut text and put it on the
Clipboard, first point to the start of the text you want to cut and
double-click the Selection button, then point to the end of the text
and double-click the Selection button again. The selected text is
highlighted. To cut the highlighted text, choose Cut from the Edit
menu. (If you decide not to cut the text you've selected, choose
Cancel from the Edit menu.) To leave the highlighted text where
it is and put a copy of it on the Clipboard, choose Copy from the
Edit menu.

You can also select text to cut or copy by positioning the Text Cursor
at the beginning of the text, choosing Mark place from the Edit
menu, moving to the end of the text, then choosing Mark place
again.

Each time you cut or copy text, the text replaces the previous
contents of the Clipboard.

To paste text from the Clipboard into a note, point to the place in
your note where you want the text to appear, click the Selection
button to reposition the Text Cursor, then choose Paste from the
Edit menu.

You can search for and replace text in a note. To search, choose Find
from the Edit menu. In the requester that appears, select the gadget
labeled “Find:”, enter the text you want to search for, then press the
RETURN key. If you want to replace this text, select the gadget
labeled “Repl:”, enter the text you want to use as a replacement,
then press the RETURN key. When you're done entering text, select
the Next Gadget to find the next occurrence of the text, or Last to
find the previous occurrence. Select CANCEL if you change your
mind about finding the text.

Once you've entered text in these gadgets, you can choose Find
Next to find the next occurrence. Find Last to find the previous
occurrence, and Replace to replace text.



Page A-6:

Page A-6:

Page A-6:

Page A-6:

Page A-6:

If you save a project that you've changed with the Notepad without
specifying an AmigaDOS directory name, the project is saved in the
same drawer as the Notepad.

In the Notepad’s submenu for Print As, the Graphic option is the
original default. To have the Draft option chosen automatically
whenever you open the Notepad, do the following:

1. Select the Notepad icon, choose Info from the Workbench menu,
select the ADD Gadget, and select the “tool types” string gad-
get—or see Page A-22 and follow that format if you want to be
consistent.

2. Type in “FLAGS =draft” and press the RETURN key.

3. Select the SAVE Gadget.

When you choose Save As, or when your note doesn’t yet have a
name and you choose Save, the String Gadget in the requester that
appears is automatically selected. This means that you can type the
name for the note as soon as the requester appears; you do not need
to select the gadget before typing.

When you save a note, the last font you chose when the Global font
option was on becomes the default font for the note. (The default
font for a note is the one that is chosen automatically when you
reopen the note.)

After you save a note, you can specify a different default font for the
note as follows:

1. Select the icon for the note, choose Info from the Workbench,
select the ADD Gadget, and select the “tool types”” string gad-
get—or see Page A-22 and follow that format if you want to be
consistent.

2. Type “FONT =" followed by the name of the font (as shown in
the Notepad’s Font menu), a period, and a number for the font
size (for example, FONT =emerald.20) and press the RETURN
key.

3. Select the Save Gadget.

13




Page A-7:

Page A-7:

Page A-8:

Page A-8:

14

When you print a note, a blank line is no longer added automatically
to the top of each page. To add blank lines, point to Print As from
the Project menu, then choose Form-feeds from the submenu that
appears.

To have the Form-feeds option chosen automatically whenever you
open the Notepad follow the steps below:

1. Select the Notepad icon, choose Info from the Workbench menu,
select the ADD Gadget, and select the “tool types” string gad-
get—or see Page A-22 and follow that format if you want to be
consistent.

2. Type “FLAGS =formfeed”” and press the RETURN key.
3. Select the SAVE Gadget.

You can change fonts within a note. First check to see if the new
Global font option in the Format menu is chosen. (The Global font
option is chosen by default when you open the Notepad unless you
make one of the changes described below. You can tell that it's
chosen if a check mark appears to the left of the Global font item in
the Format menu.) If the option is chosen, choose the Global font
item to turn it off. You can change the font and size of newly entered
text by choosing a new item from the Font menu.

You can specify whether or not the Global font option is chosen
when you open the Notepad or a note as follows:

1. Select the icon for the Notepad, choose Info from the Workbench
menu, select the ADD Gadget, and select the “'tool types” string
gadget—or see Page A-22 and follow that format if you want to
be consistent.

2. To have the Global font option chosen automatically when you
open the Notepad or a note, type “FLAGS =global” and press
the RETURN key. To specify that the Global font option NOT be
chosen when you open the Notepad or a note, type in “FLAGS
=local” and press the RETURN key.

3. Select the SAVE Gadget.



Page A-9:

Page A-9:

Page A-9:

If you enter FLAGS =global, font changes in a note are not pre-
served when you reopen the note; the characters all become the
current default font.

Word wrap is a new option in the Format menu. Word wrap is
chosen when you open the Notepad; when it’s chosen, the Notepad
ends each line of text at the end of a word. A check mark to the left
of the Word wrap menu item indicates that the option is chosen. To
turn off the word wrap feature, choose the Word wrap item. To turn
the feature back on, choose the Word wrap item again.

To turn off the Word wrap feature automatically whenever you
open the Notepad follow these steps:

1. Select the Notepad icon, choose Info from the Workbench menu,
select the ADD Gadget, and select the “tool types” string gad-
get—or see Page A-22 and follow that format if you want to be
consistent.

2. Type “FLAGS =nowrap” and press the RETURN key.
3. Select the SAVE Gadget.

You can make an entire note appear in the same font by choosing
Remove fonts from the Format menu.

You can remove all style changes (changes from and to italic, bold,
underline, or plain text) in a note by choosing Remove styles from
the Format menu.

15




Page A-9: There are a number of new menu shortcuts. These shortcuts are
shown to the right of the menu items. To use these shortcuts, hold
down the right Amiga key, then with the key still held down, press
the other key shown:

Open

Save
Cancel
Cut

Paste
Copy
Mark place
Find

Find Next
Find Previous
Replace
Plain

[talic

Bold
Underline

+TZNeXO0WYO

C®™—= TR

In addition, entering CTRL-L redraws what appears in the Notepad
window. (To enter a CTRL-L character, hold down the CTRL key on
the keyboard while you press the L key, then release both keys.)

Page A-22: There are now several different keyboards available for the Amiga.
SetMap is a new Workbench tool that lets you use other keyboards.
You use SetMap to select the correct “’key map”’: a list that tells your
Amiga the right character to print for each key on a keyboard.

The SetMap tool is in the System drawer on the Workbench. To use
SetMap, open the System drawer, then follow the steps below:

1. Select the SetMap icon.

2. Choose Info from the Workbench menu.

16



3. In the requester that appears, select the ADD Gadget to the right
of the words TOOL TYPES.

4. Select the String Gadget between the ADD Gadget and the words
TOOL TYPES.

5. Type “KEYMAP =" followed by the name of a new key map. The
key maps available are:

d

e

f
gb
i

is

s
dk
n
cdn
usa

usal

usa2

for German keyboards

for Spanish keyboards

for French keyboards

for British keyboards

for Italian keyboards

for Icelandic keyboards

for Swedish keyboards

for Danish keyboards

for Norwegian keyboards

for French Canadian keyboards
for standard United States keyboards

This is the key map provided with the 1.1 release of
the Amiga system software. Some programs may
require this key map to function properly.

for Dvorak keyboards

When you’ve finished entering the name of the key map, press
the RETURN key.

6. Select the SAVE Gadget at the lower left of the requester.

7. When the Workbench reappears, point to the SetMap icon, then
double-click the Selection button.

Not all of the keyboards listed above, and shown on the following
pages, are currently manufactured.
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Each key map has a set of alternate characters. The alternate charac-
ter set includes special symbols and diacritical marks used in each
language. To enter an alternate character, hold down the ALT key
while pressing another key on the keyboard.

Included among the alternate characters in the new key maps are
““dead” keys. These keys allow you to add accents and other diacrit-
ical marks to selected characters. When you press a ““dead” key, the
cursor does not advance; thus the diacritical mark and the next
character you type appear in the same position. Not all characters
can be combined with “dead” keys.

KEYTOY, a new tool on the Extras disk, allows you to separately
display each key map.

GraphicDump and Say

Two new features have been added to the Workbench. These are GraphicDump and
Say. GraphicDump lets you print entire screen images, including menus and icons, just
as they appear on your monitor. Say lets you type words and sentences, which the
Amiga then “says” using its audio capabilities.

Both GraphicDump and Say have icons in the System drawer in the Workbench win-
dow.

GraphicDump

To use GraphicDump, open the System drawer of the Workbench and double-click on
the GraphicDump icon. After a delay of approximately 10 seconds, the entire screen
image that is foremost on the monitor is “dumped” to the printer. (You must have a
graphics printer connected to your Amiga and properly selected in Preferences.)

The 10-second delay allows you time to move images on the screen, open menus, or
move the current Workbench screen to the back and let another screen image be printed.




Say

Use the Say feature by opening the System drawer and double-clicking on the Say icon.
Two new windows will open. One is labeled “Phoneme window” and the other is
labeled “Input window.”

Activate the input window by moving the pointer into it and clicking with the mouse.
Now type the words or sentences you want the Amiga to “speak” and press Return.
You'll hear the Amiga repeating your words.

If you type long lines or sentences, don’t press Return when you reach the right edge of
the input window. The text will automatically wrap around the next line. Don’t worry if
the line is broken in the middle of a word.

You can use the standard Amiga window manipulation techniques to move or change
the size of both the phoneme and input windows.

After you typed in your words and pressed Return, you may have noticed that text
appears in the phoneme window just before the Amiga speaks. This display is a
phonetic interpretation of your words (that is, it is an interpretation of the sounds
necessary to speak the words. Say translates what you type into sounds using a phonetic
alphabet and phonetic rules. This translation is printed in the phoneme window.

To use and enjoy Say you don’t need to learn all the rules of phonetics. However, since
phonetic spelling is based on how words sound rather than how they are conventionally
spelled, you should think in terms of sounds and at the same time watch how Say spells
different words (or sounds) in the input window. A good dictionary will be helpful for
looking up the pronunciation of words you are uncertain about.

You can change the voice, pitch, and speed of your Amiga’s speech by choosing
different options in the phoneme window.

You have a choice of a male, female, robot, or natural voice. Select which voice you want
by typing the appropriate code below in the phoneme window:
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-m for male voice

—f for female voice
-r for robot voice
-n for natural voice

For example, to change to the female voice type —f in the phoneme window and press
return.

To change the pitch of the voice, in the phoneme window type —p followed by a number
of 65 through 320, for example:

-p89 <return>
The higher the number you type, the higher the voice’s pitch will be.

To change the speed of the voice, in the phoneme window type —s followed by a number
of 40 through 400, for example:

-s321 <return>
The higher the number you type, the faster the voice will speak.

To close Say just move the pointer into the input window, activate the window by
clicking with the mouse, and then press return without typing any words first.

20




Printer Escape Sequences
The Amiga printer device accepts standard escape sequences that are translated into
escape sequences specific to the printer selected in Preferences. When using the printer
device or printer handler (PRT:), use these standard sequences to implement special
printer features. If the feature is not supported by your printer or driver, the sequence
will be ignored.
To send a command to the printer from CLI follow the steps below.
1. Redirect the keyboard to the printer by typing the following:

copy * to prt:<return>
2. Wait until disk access stops.
3. Type an escape sequence, for example the NLQ On command:

<ESC>[2"z

What you type will not be echoed on the screen.

4. Hold down the Control key and press the backslash key (\) to terminate the keyboard
file.

If your printer supports NLQ mode, NLQ will now be on. Any file you COPY or TYPE to
prt: will be printed in near letter quality. You can also use the four steps above to create
small printer command files. For example, you could replace the prt: in step 1 with
ram:NLQon. Then the four steps will create a file called NLQon in ram:. To turn on
NLQ, copy ram:NLQon to prt:
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ANSI X3.64 Style Commands

Note: ESC is the Escape key if you are typing a sequence from the keyboard. In BASIC, it

is CHR$(27). In C /033 can be used.

Label
aRIS
aRIN
aIND
aNEL
aRI

aSGRO
aSGR3
aSGR23
aSGR4
aSGR24
aSGR1
aSGR22
aSFC
aSBC

Label
aSHORPO
aSHORP
aSHORP1
aSHORP4
aSHORP3
aSHORP6
aSHORP5

aDENG6
aDEN5
aDEN4
aDEN3
aDEN2
aDEN1

22

Escape Sequence
ESCc

ESC#1

ESCD

ESCE

ESCM

ESC[0m

ESC[3m

ESC[23m

ESC[4m

ESC[24m

ESC[1m

ESC[22m

ESC[30m to ESC[39m
ESC[40m to ESC[49m

Escape Sequence
ESC[0w
ESC[2w
ESC[1w
ESC[4w
ESC3w
ESCéw
ESC[5w

ESC[6"z
ESC[5"z
ESC[4"z
ESC[3"z
ESC[2"z
ESC[1"z

Feature

reset

initialize

line feed

return line feed
reverse line feed

normal character set
italics on

italics off

underline on
underline off
boldface on

boldface off

set foreground color
set background color

Feature

normal pitch

elite on

elite off
condensed fine on
condensed off
enlarged on
enlarged off

shadow print on
shadow print off
doublestrike on
doublestrike off
NLQ on

NLQ off




aSus2
aSUS1
aSUs4
aSuS3
aSuso
aPLU

aPLD

aFNTO
aFNT1
aFNT2
aFNT3
aFNT4
aFNT5
aFNT6
aFNT7
aFNT8
aFNT9
aFNT10

aPROP2
aPROP1
aPROPO
aTSsS
aJFY5

Label
aJFY7
aJFYé6
aJFY0
aJFY3
aJFY1

aVERP0
aVERP1
aSLPP
aPERF
aPERF0

ESC[2v
ESC[1v
ESC[4v
ESC[3v
ESC[Ov
ESC1
ESCK

ESC(B
ESC(R
ESC(K
ESC(A
ESC(E
ESC(H
ESC(Y
ESC(Z
ESC(
ESC(6
ESC(C
ESC[2p

ESC[1p

ESC[0p

ESC[n E
ESC[5 F

Escape Sequence
ESC[7 F
ESC[6 F
ESC[OF
ESC[3 F
ESC[1F

ESC[0z
ESCJ[1z
ESC[nt
ESC[nq
ESC[0q

superscript on
superscript off
subscript on
subscript off
normalize the line
partial line up
partial line down

US character set
French character set
German character set
UK character set
Danish I character set
Swedish character set
[talian character set
Spanish character set
Japanese character set
Norwegian character set
Danish II character set

proportional spacing on
proportional spacing off
proportional spacing clear
set proportional offset
auto left justify

Feature

auto right justify
auto full justify

auto justify off

letter space (justify)
word fill (auto center)

¥&" line spacing
" line spacing
set form length n
perf skip n (n > 0)
perf skip off




aLMS ESC#9
aRMS ESC#0
aTMS ESC#8
aBMS ESC#2
aSTBM ESC[Pn1;pn2r
aSLRM ESC[Pn;Pn2s
aCAM ESC#3

aHTS ESCH

aVTS ESC]

aTBCO0 ESC[0g
aTBC3 ESC(3g
aTBCl1 ESC[1g
aTBC4 ESC[4g
aTBCALL ESC#4
aTBSALL ESC#5
aESTEND ESC[Pn"x
ADDITIONAL NOTES

The system software now supports both the NTSC and PAL video standards. If a special
custom chip for PAL has been installed in your Amiga, 256 horizontal lines appear on

left margin set

right margin set

top margin set

bottom margin set

top and bottom margins
left and right margins
clear margins

set horizontal tab

set vertical tabs

clear horizontal tab

clear all horizontal tabs

clear vertical tabs

clear all vertical tabs

clear all horizontal and vertical tabs
set default tabs

extended commands

normal video displays; 512 horizontal lines appear on interlaced displays.

The new software also detects the frequency of the AC line current (50 or 60 Hz) and

automatically uses the right frequency for internal timekeeping.
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The AmigaDOS Manual:
Update to the First Edition for
Amiga System Software Release 1.2

The RAM: device now writes to files in blocks of 512 bytes.

To create a RAM: device each time you boot, edit your startup file to
include the line:

dir ram:

When you enter the ASSIGN LIST command, full directory names
now appear.

There is a new command, ADDBUFFERS:

Format: ADDBUFFERS df<x>: <nn>

Purpose: to reduce disk access time by adding sector cache
buffers

Specification:

Adds <nn> buffers to the list of sector caches for drive <x>.
Adding additional buffers can significantly reduce disk access time.
The tradeoff is that the command uses up memory; each buffer
added reduces memory by approximately 500 bytes.

The improvement in disk access time is less pronounced when you
add more than 25-30 extra buffers.
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Example:
ADDBUFFERS dfl: 25
Adds 25 buffers to the sector caches for disk drive dfl:. If you are

unsure about the number of buffers to add for your application, this
is a good number to start with.

There is a new command, BINDDRIVERS:

Format: BINDDRIVERS
Purpose: To bind device drivers for add-on hardware
Specification:

The BINDDRIVERS command is normally part of a startup script. It
is used to bind device drivers found in the directory SYS:Expansion
to add-on hardware that has been automatically configured by the
expansion library. (For end users, this means that if icons for expan-
sion hardware are in the Expansion drawer on the Workbench, the
hardware will be configured automatically when they boot up.)

Example:

BINDDRIVERS

There is a new command, CHANGETASKPRI:

Format: CHANGETASKPRI <priority>
Purpose: To change the priority of CLI tasks
Specification:

The Amiga uses the priority numbers to determine which of the
tasks currently running it must attend to. Normally most user tasks
have a priority of 0, and the time and instruction cycles of the CPU
are time-sliced among them.



Page 45:

Page 48:

Page 49:

The CHANGETASKPRI command changes the priority of the CLI
task from which it’s run. Tasks started from this CLI inherit its

priority.

Although priority numbers can range from —128 to +127, you
should only enter values from —5 to +5 to avoid disrupting impor-
tant system tasks. The command does not check for the value of
<priority>.

Example:
CHANGETASKPRI 5
This CLI task, and any other tasks started from it, will have priority

over any user tasks created without the CHANGETASKPRI com-
mand.

Because of improved disk caching and a new disk layout, you can
improve your Amiga’s performance by copying an existing disk
onto a different disk with the COPY ALL command.

You can now halt output from the DIR command by entering CTRL-C.

There is a new command: DISKCHANGE:

Format: DISKCHANGE <dr>

Purpose: To tell AmigaDOS that you've changed disks in a
5%4" disk drive

Specification:

Enter the DISKCHANGE command to inform AmigaDOS that

you’ve changed disks in drive <dr>:. This is necessary for 5%4" disk
drives that do not detect when a disk has been changed.

27
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Example:

A requester appears that asks you to insert BigDisk into drive df2:. If
df2:is a 5%4" drive, you must insert the disk and enter the command:

DISKCHANGE df2:

before AmigaDOS will continue.

DISKCOPY now works with any disks (including hard disks, disk
partitions, and 5%" disks) that have been mounted with the

MOUNT command providing that those disks and partitions are the
same size.

There is a new requester for Diskcopy:

Diskcopy:
Failed to open icon.library
Retry Cancel

The requester appears when Diskcopy cannot gain access to the icon
library kept on the Workbench disk. This can happen if you do the
following:

Copy c:diskcopy TO ram:

[Remove the Workbench disk.]

DISKCOPY

[A requester appears that asks you for the disk that has the LIBS:
directory on it; this is normally the Workbench disk.]

[Select the Cancel gadget in the requester.]

If the requester appears, insert the Workbench disk.

(Technical note: Diskcopy retries the OpenLibrary call when this
occurs. The retry flag is DISKINSERTED.)
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There is a new command, DISKDOCTOR:

Format: DISKDOCTOR <dr>:
Purpose: To fix a corrupted disk in drive <dr>:
Specification:

If AmigaDOS detects a corrupted disk, it will display a message
saying that the disk could not be validated. (A disk may be corrupt-
ed if, for example, you remove it from a drive while the disk drive
light is still lit.) DISKDOCTOR restores as much of the file structure
as it can. After you've run DISKDOCTOR, you should copy all the
files that you want to keep onto another disk, and then reformat the
corrupted disk.

Example:

AmigaDOS has detected a corrupted disk if you see requesters like:
Volume

Textfiles

is not validated

or

Error validating disks
Disk is unreadable

If the disk is in drive dfl:, enter:
DISKDOCTOR dfl:
After DISKDOCTOR has finished, it will display the message:

Now copy files required to a new disk and reformat this disk.
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When you use EXECUTE, it now creates a T: directory if one doesn’t
already exist.

FORMAT now works with any disks (including hard disks, disk
partitions, and 5%" disks) that have been mounted with the
MOUNT command. The syntax of the FORMAT command is:

FORMAT DRIVE <drivename>: NAME <diskname> [NOICONS]

Unless you include the NOICONS option, a Trashcan icon will be
added to the disk you format. You can stop the command before it is
finished by entering CTRL-C.

When used from the CLI, FORMAT now re-searches the command
directory path if the first search fails. This is done under the as-
sumption that the user may have inserted a disk as a result of a
requester making one or more of the path directories valid. Thus,
the path is searched twice before the command fails.

The INITIALIZE command is a new Workbench menu option. Like
the FORMAT command, it works with any disks (including hard
disks, disk partitions, and 5%" disks) that have been mounted with
the MOUNT command.

When you use INITIALIZE, a Trashcan icon is added to the disk. If
you have your SYS: disk in any drive it will use the Trashcan image
on that disk for the new trashcan. Otherwise the new Trashcan
image that appears on new Workbench disks is added. To provide
compatibility with the old FORMAT command, INITIALIZE has a
NOICON option to make completely blank disks. To stop the initial-
ization of a disk before INITIALIZE is finished, enter CTRL-C at the
keyboard.
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There is a new command, MOUNT:

Format: MOUNT <dr>:

Purpose: To make a new device (such as a disk drive) avail-
able.

Specification:

To use a new device with the Amiga, you must first create an entry
for the device in the file devs:Mountlist. Then you enter the
MOUNT command to make the device available. MOUNT com-
mands are normally included in the file s/Startup-Sequence.

Normally hardware manufacturers will supply the proper proce-
dures for installing their devices. If not, the file devs:Mountlist

contains an entry for using an A1020 5%4" disk drive, which you can
modify for other devices.

The format for an entry in the dev:Mountlist file is:

DF2: Device = trackdisk.device

Unit = 2
Flags = 1
Surface = 2

BlocksPerTrack = 11
Reserved = 2

PreAlloc = 11

Interleave = 0

LowCyl = 0; HighCyl = 39
Buffers = 5

BufMemType = 3

You can include more than one description on the same line if you
separate the descriptions with semicolons (;). Numbers are assumed
to be decimal unless they are preceded by 0x in which case they are
treated as hexadecimal. Comments may be placed in the file as in
C programs.
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If the device is not a storage device, you can use this format for the
entry.

AUX Handler = 1l:aux-handler

Stacksize = 700
Priority = 5

There is a new FROM option for the NEWCLI. The new format for
the NEWCLI command is:

NEWCLI [FROM <filename>]

Including FROM <filename> causes the new CLI you create with
the NEWCLI command to execute the commands in <filename>
when it’s started.

The Notepad can now be run from the CLI. The syntax is:

[run] notepad [ [ [—q ] <filename>] | ?]

where the —q option opens the Notepad without reading in fonts
from disk, <filename> is the name of a file to be opened, and the

? option shows the syntax of the command without opening the
Notepad.

There is a new command: PATH:

Format: PATH [SHOW] | [ADD <directoryname>
[, <directoryname>] ... ] | [RESET <directoryname>
[, <directoryname>] ... ]

Purpose: To add, see, or change the directories in which

AmigaDOS searches for commands to execute.



Specification:

The PATH command lets you add, see, or change “‘search paths’:
directories that AmigaDOS searches when looking for a program to
execute. By default, AmigaDOS searches the current working direc-
tory, then the SYS:c directory for a program. Enter the PATH com-
mand with the SHOW parameter or without parameters to show the
current search paths. Enter the PATH command with one or more
directory names to specify search paths; these paths replace any
paths you defined before. Enter PATH ADD followed by one or
more directory names to add paths to those you've already defined.

You can add up to ten directories with one PATH ADD command;
names of the directories must be separated by at least one space.
The ADD keyword is optional.

Replace the existing search path with one of your own by typing
PATH RESET followed by the names of the directories. The existing
search path (except for the current directory and SYS:C) is erased
and the new one substituted.

Restore the search path to its default state (searching only the
current directory and SYS:c), by typing PATH RESET. This com-
mand undoes the effect of the PATH ADD command in a startup
file.

To see a listing of the current search path, type PATH SHOW or just
PATH.

Keywords can go at the beginning or the end of a command line. For

example, you can type PATH <file1> <file2> RESET or PATH
RESET <filel> <file2>
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Examples:

PATH SHOW  (or PATH)
displays the directories in which AmigaDOS will search for com-
mands. A typical search path would be:

Current directory
Workbench:System
C:

PATH ADD SYS:newcommands (or PATH SYS:newcommands)

AmigaDOS will then search for commands located in SYS:newcom-
mands directory. (By default, the s/Startup-Sequence file includes a
PATH ADD SYS:System command.)

Current directory
Workbench:System
Workbench:newcommands

C:

You may want to add this command to your s/Startup-Sequence file
so that AmigaDOS automatically searches the SYS:newcommands
any time you use that disk. If you look at the s/Startup-Sequence
file, you will see that this is how SYS:System has been added to the
search path.

The PROTECT command has been modified to alter only the lower
four bits of the protection field and preserve the other bits. It
previously set all bits to 1. Bit 4 of the protection field (the archive
bit) is now cleared whenever a file that has been written to is closed
or a directory is updated. This allows an archiving program to scan a
disk and detect those files that have been altered since it last ran. It
causes the protect function to set the archive bit to mark the file as
archived.

Entering the RUN command no longer changes the priority of your
CLIL
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There is a new command, SETDATE:

Format: SETDATE <file> <date> [<time>]

Purpose: To change the timestamp associated with a file or
directory.

Specification:

This command lets you change the timestamp associated with a file

or directory.

There is a new command: SETMAP:

Format: SETMAP <mapfilename>

Purpose: To change the key map for the keyboard to one for
another country.

There are now alternate key maps for keyboards used in countries

other than the U.S.A. See the 1.2 update to Introduction to Amiga

for more information about keymaps and illustrations of available

keyboards.

The :devs/keymaps directory contains the names of the keymap files
available on the Workbench disk.

To get back the default key map stored in read-only memory, enter
the CLI command:

SETMAP usa

You can edit your startup script to include a SETMAP command.

There is a new command, SETTASKPRI:

Format: SETTASKPRI <priority>
Purpose: To change the priority of a CLI task.
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Specification:

You use the SETTASKPRI command to change the priority of the
CLI task from which you enter the command. In turn, tasks started
from this CLI inherit its priority.

SETTASKPRI does not check for appropriate values for <priority>.
To avoid disrupting important system tasks, enter values from —5
to +5 for <priority>.

When you run EDIT, it now creates a T: directory if one doesn’t
already exist.

Step 3 in the example for ExNext( ) should read: “Keep calling
ExNext( ) until it fails. Then, if the error code held in IoErr( ) is
equal to ERROR NO MORE ENTRIES, you're finished.”

There is a new accessMode for opening files: MODE_READWRITE
(= 1004). This mode opens an old file with an exclusive lock. In
addition, you can now use the identifier MODE READONLY as a
synonym for MODE_OLDFILE.

WaitForChar ( ) cannot be used on noninteractive streams.

If a command you call with the Execute( ) function calls Exit( ),
Execute( ) returns the value passed to Exit( ).

DISKED now works with any disks (including hard disks, disk
partitions, and 5%" disks) that have been mounted with the
MOUNT command.

Printa & stripa now handle debug hunks.



Page 272:

There is a new packet action type: SetFileDate (= 34). You use this
new packet type to set the date of a file or directory to a specified
value. The first argument is a lock and the second argument is an
APTR to an AmigaDOS date stamp returned by the DateStamp( )
routine.

There is another new packet action type: SetRawMode (= 994). This
new mode is used to change the CON: device so that it behaves like
the RAW: device, and to change it back to its normal state. Include
the TRUE argument to select raw mode (so that it behaves like
RAW:). Include the FALSE argument to return the console device to
its normal state.

There is, however, a difference between the RAW: device and the
CON: device in raw mode. CON: in either normal or raw mode
accepts the escape sequences to enable and disable the conversion of
a linefeed character to carriage return + linefeed. RAW: does not
translate linefeeds. (The sequences are CSI 20h to enable translation
and CSI 201 to disable it.)
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Amiga ROM Kernel Reference Manual:
Update to the Addison-Wesley Edition for
Amiga System Software Release 1.2

Changes to Volume I: Exec

Page ix: Exec now supports the 68881 math coprocessor in a multitasking
environment.

Page 25: Exec has new Signal Semaphore functions:
InitSemaphore( ) and ObtainSemaphore( ). See exec.doc for more
information.

Page 65: Support for the Amiga Expansion Architecture is now included in

Exec. As a result, many system data structures, such as SysBase and
GfxBase, should appear in fast memory if it is available.

Page 72: There are two new Exec functions that deal with memory. Copy-
Mem( ) allows you to move memory quickly and safely. AddMem-
List( ) adds memory to the system. See exec.doc for more informa-
tion.

Page 82: Exec can now find code modules in ram at system bring-up time.
This new “romtags in ram” facility will allow developers to override
individual Kickstart modules and add new modules.
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Page A-2:

Page B-1:

Exec now displays different text in an alert if the alert is one that is
recoverable.

Exec will ignore the old ExecBase if the version or revision of exec
has changed.

Changes to Volume II: Libraries and Devices

Page iii:

Page 3:

Page 13:

Page 14:

40

The library version number for this release is 33.

The 1.2 system software now supports both the NTSC and PAL
video standards. If a special custom chip for PAL has been installed
in an Amiga, there are 256 horizontal lines on the display (512 if
you’ve chosen Workbench Interlace in Preferences). You also get the
50 Hz refresh rate required by the PAL standard.

THIS RELEASE ALSO DETECTS THE FREQUENCY OF THE AC
LINE CURRENT (EITHER 50 or 60 Hz) AND AUTOMATICALLY
USES THE RIGHT FREQUENCY WHEN UPDATING THE AMI-
GA’S INTERNAL CLOCK.

There is a new graphics function, SetRGB4CM( ).

It sets one color register for a ColorMap structure. This function can
be used to set up a ColorMap before linking it into a viewport.

See graphics.doc for more details.

There is a new graphics routine, SetRGB4CM( ).
It is similar to SetRGB4( ) except that it takes a ColorMap as a
parameter instead of a ViewPort.

A note to programmers: don’t appropriate the ColorTable pointer in
ColorMap. Amiga reserves the right to use additional bits for the
color map in future releases.



Page 26:

Page 42:

Page 42:

Page 42:

To maintain compatibility with different standard screen sizes, pro-
grammers should get the normal display dimensions of a screen
from GfxBase->NormalDisplayRows and GfxBase->NormalDis-
playColumns. For NTSC the height is currently set to 200 at power
up and to 256 for PAL at power up.

There are also new values in GfxBase for the maximum value for
row and column in a ViewPort structure. Programmers should get
these maximum values from GfxBase->MaxDisplayRows and
GfxBase->MaxDisplayColumns.

Programmers should use the NTSC and PAL bits in GfxBase to
maintain compatibility with future changes. For 1.2, using these bits
will yield either 262 or 312 lines per frame.

There is a new graphics macro, DrawCircle.

It calls DrawEllipse( ) with a centerpoint and radii to create a circu-
lar outline in a rastport using the current pen color, at the specified
position. It clips the result in a layered rastport.

See graphics/gfxmacros.h for macro definition.

There is a new graphics function, DrawEllipse( ).

It draws an elliptical outline into a rastport using the current pen
color, at the specified position. It clips in layered rastports.

See graphics.doc for more details.

There is a new graphics macro, AreaCircle.

It calls AreaEllipse( ) with a centerpoint and radii to create a filled
circle in a rastport using current pattern, drawmode, and pen colors.
User must have initialized valid TmpRas and Arealnfo structures.
This routine may be integrated with calls to other AreaFill routines
(e.g. AreaMove, AreaDraw, AreaEnd).

See graphics/gfxmacros.h for macro definition.
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Page 42:

Page 42:

Page 42:

Page 43:

Page 45:

Page 48:

Page 51:
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There is a new graphics function, AreaEllipse( ).

It is an AreaFill routine that fills an ellipse in the specified rastport
using current pattern, drawmode, and pen colors. User must have
initialized valid TmpRas and Arealnfo structures. This routine may
be integrated with calls to other AreaFill routines; (e.g. AreaMove,
AreaDraw, AreaEnd).

See graphics.doc for more details.

There is a new graphics function, BltBitMapRastPort( ).

It blits from source bitmap to destination rastport using specified
minterm, clipping the result in a layered rastport.

See graphics.doc for more details.

There is a new graphics function, BltMaskBitMapRastPort( ).

It blits from source bitmap to destination rastport with masking of
source image, clipping the result in a layered rastport.

See graphics.doc for more details.

The WritePixel( ) function now waits for the blitter to complete
between each of the blits. It is a little slower as a result.

The AreaEnd( ) function now returns 0 if no error occurred.

RectFill( ) still has a bug in COMPLEMENT mode: It complements
all bit-planes rather than only those planes in which the foreground
pen is non-zero.

To maintain compatibility with software written under 1.1, THIS

BUG WILL NOT BE FIXED.

Using ScrollRaster( ) for simple refresh layers scrolls the appropri-
ate existing damage region.




Page 79:

Page 81:

Page 95:

Page 95:

Page 96:

Page 96:

There is a new graphics function: AttemptLockLayerRom( ).

It attempts to obtain a lock on a layer. It does not block if a lock
cannot be obtained. It returns the result of the attempt to caller.
See graphics.doc for more details.

There is a new graphics function: AttemptLockLayerRom( ).

It tries to obtain a layer lock, but does not block if attempt was
unsuccessful. It returns a boolean value to indicate success or failure
in obtaining the lock.

There is a new graphics function, InstallClipRegion( ).

It installs a transparent Clip region in a layer. Subsequent graphics
calls will be clipped to this region. It returns a pointer to the pre-
vious Clip region.

See layers.doc for more details.

BeginUpdate( ) now assumes it has enough memory until it discov-
ers otherwise.

There is a new graphics function, ClearRectRegion( ).

It clips away any portion of the region that exists inside of the
rectangle, and leaves the result in the region. It returns a code
indicating whether it succeeded or failed to the to calling program.
See graphics.doc for more details.

There is a new graphics function, OrRegionRegion( ).

It performs the logical inclusive OR of two regions. It returns a code
indicating whether it succeeded or failed to the to calling program,
and leaves the result in the second region.

See graphics.doc for more details.
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Page 96:

Page 96:

Page 106:

Page 108:

Page 195:

Page 201:

Page 225:

Page 263:

There is a new graphics function, XorRegionRegion( ).

It performs the logical exclusive OR of two regions. It returns a code
indicating whether it succeeded or failed to the to calling program,
and leaves the result in the second region.

See graphics.doc for more details. graphics/AndRegionRegion

There is a new graphics function, AndRegionRegion( ).

It performs the logical AND of two regions. It returns a code indicat-
ing whether it succeeded -or failed to the to calling program, and
leaves the result in the second region.

See graphics.doc for more details.

Programmers who can expect a performance improvement of about
15% in code that uses Gels.

Sprite movement is now restricted to the limits imposed by the
Amiga hardware. As a result, the absolute starting position of a
Sprite must not occur before line 20.

The proper order of parameters for the SetFont( ) function should
be SetFont(rp, font).

There is a new font, Topazll, for use in interlaced screens.

The audio device now resets audio channels whenever they are
allocated instead of only when they are freed or stolen.

The actual step rate for the trackdisk device is now down to 3.6msec.
To learn how to fine-tune the step rate, see the descriptions of
tdu_StepDelay, tdu_SettleDelay in trackdisk.h. These parameters are
extremely hardware dependent! This means that values that may
work for a 68000 may not work for a 68010 as well as a 68020 or a
faster clock, etc.



Page 297:

Page 390:

Page 413:

Page 418:

Page 418:

Page 418:

Page 420:

Page 422:

Page 427:

Page 455:

The new console device re-establishes a keymap conversion buffer
size of 127. This means that keys can be mapped to longer strings.

MARK/SPACE is now supported by serial device.
The serial device now waits 12 seconds, rather than 90 micro-

seconds, before giving up on CTS/RTS handshaking.

All printers now have a defined extended character set for charac-
ters with values greater than 159.

The printer device now only reloads the printer dependent portion
when necessary.

The printer device now reinitializes the printer only when printer
preferences have been changed.

Tasks calling the printer.device work always put up error requesters
in the workbench screen.

The printer device only generates an aRIN (which produces a line-
feed) if printer preference variables are changed.

In the printer device, DISABLE/ENABLE now surround the printer
status checking code.

The printer device now supports PAL screen sizes.

The Mathffp library now supports Ceil, Floor.
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Page 474:

Page 483:

Page 486:

Page D-48:

Page D-122:

Page D-122:

Page D-122:
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IEEEDPFix( ) in mathieeedoubbas.library now returns 0 instead of
the error value 107 when there is an overflow.

Workbench arranges to have its autorequest messages be marked
with its name (“Workbench”) in the title bar.

Workbench now looks for initialize as either “’sys:system/initialize”
or “’sys:system/format”’

The name DPI in GfxBase has been changed to DPM; it now repre-
sents DotsPerMeter for both X and Y values in displays. Use these
values to calculate display aspect ratios. These values will be differ-
ent for NTSC and PAL.

The Okimate-20 now supports colored text.

The driver for the Apple ImageWriter II printer now has improved
characters in the extended character set.

There is a new driver for the IBM compatible Okidata 292.



Printer.Device/DumpRPort

NAME

DumpRPort — dump the specified RastPort to a graphics printer.

FUNCTION

Print a rendition of the supplied RastPort, using the supplied ColorMap, position and
scaling information, as specified in the printer preferences.

10 REQUEST
io_Message
io_Command
io Flags

io RastPort
io_ColorMap
io Modes

io SrcX
io_SrcY

io SrcWidth
io_SrcHeight
io_DestCols
io_DestRows

io_Special

mn_ReplyPort set if quick I/O is not possible
PRD_DUMPRPORT
I0B_QUICK set if quick I/O is possible
ptr to a RastPort.
ptr to a ColorMap.
the ‘modes’ flag as from a ViewPort structure
the upper word is reserved and should be zero
the x offset into the RastPort
the y offset into the RastPort
the x size in the RastPort to be printed
the y size in the RastPort to be printed

these two parameters describe the size of the area to print to on

the printer, as described below.

interpretation of Dest parameters:

® if SPECIAL MIL is set, then the associated parameter is
specified in thousandths of an inch on the printer.

e if SPECIAL FULL is set, then the dimension is set to the
maximum possible (as determined by the printer limits or
the configuration limits, whichever is less).

® if SPECIAL FRAC is set, the parameter is taken to be a
longword binary fraction of the maximum for that dimen-
sion.

® if ASPECT is set, one of the dimensions may be reduced to
preserve the aspect ratio of the print.

® if all bits for a dimension are clear, the parameter is specified
in printer pixels.
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e if SPECIAL DENSITY(1-4) is set, then the printer specific
driver has the option of selecting a different dots per inch
density (dpi) than the default one. As of this writing, the
printer specific modules supporting this feature are the
HP LASERJET & the HP LASERJET PLUS. For these two
printers, the densities are 75, 100, 150 & 300 dpi respectively.
The HP_LASERJET always defaults to 75 dpi. The
HP_LASERJET PLUS defaults to 100 dpi if the preferences is
set to DRAFT quality and 150 dpi with LETTER quality.

® if SPECIAL_CENTER is set, then the picture will be horizon-
tally centered on the paper.

There exist rules for the interpretation of io_DestRows and io_Destcols that may
produce unexpected results when they are not greater than zero and io_Special is
zero. They have been retained for compatibility. The user will not trigger these other
rules with well formed usage of io_Special.

HINTS

48

The printer selected in preferences must have graphics capability to use this com-
mand.

Color printers may not be able to print black and white or greyscale pictures —
specifically, the Okimate 20 cannot print these with a color ribbon: use a black one.

If the printer has an input buffer option, use it.

If the printer can be uni- or bi-directional, select uni-directional; this produces a much
cleaner picture and in some cases a faster printout.

Please note that the width and height of the printable area on the printer is in terms of
pixels and bounded by the following:
a) WIDTH = (RIGHT MARGIN — LEFT MARGIN + 1) / CHARACTERS PER INCH
b) HEIGHT = LENGTH / LINES PER INCH

For BGR printer support, the YMC values in the printer specific render.c functions
equate to BGR respectively, i.e. yellow is blue, magenta is green, and cyan is red.

The special rules for io_DestRows and io_DestCols (WHICH TAKE EFFECT ONLY IF

IO_SPECIAL IS 0) are:

a) DestCols>0 & DestRows>0 — use as absolute values. ie. DestCols =320 & Dest-
Rows =200 means that the picture will appear on the printer as 320 x 200 dots.



b)

Q)

DestCols =0 & DestRows>0 — use the printers maximum number of columns and

print DestRows lines. ie. if DestCols=0 and DestRows =200 than the picture will

appear on the printer as wide as it can be and 200 dots high.

Destcols =0 and DestRows =0 — same as above except the driver determines the

proper number of lines to print based on the aspect ratio of the printer. ie. This

results in the largest picture possible that is not distorted or inverted. Note: As of

this writing, this is all the call made by such program as DeluxePaint, Graphic-

Craft, and AegisImages.

DestCols>0 & DestRows =0 — use the specified width and the driver determines

the proper number of lines to print based on the aspect ratio of the printer. ie. If

you desire a picture that is 500 pixels wide and aspect ratio correct, use Dest-

Cols =500 and DestRows =0.

DestCols<0 or DestRows>0 — the final picture is either a reduction or expansion

based on the fraction |DestCols| /DestRows in the proper aspect ratio.

Some examples:

1) if DestCols= -2 & DestRows=1 then the printed picture will be 2x the
AMIGA picture and in the proper aspect ratio. (2x is derived from
| =2| /1 which gives 2.0)

2) if DestCols= —1 & DestRows=2 then the printed picture will be 12X the
AMIGA picture in the proper aspect ratio. (2Xx is derived from
| =1| /2 which gives 0.5)
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Intuition Version 33 (v1.2 Amiga System
Software Release)

1. INTRODUCTION
This document describes changes and key observations for the revision to Intuition
which is part of the v1.2 Kickstart or ROM software.

This exposition is directed at the software developer who is already familiar with the
Intuition library, who has read the Intuition Reference Manual carefully in the areas
discussed. Particular familiarity is assumed of the usage and methods of the Intuition
Direct Communications Message Port IDCMP).

The “autodocs” are a reference resource for Intuition and the entire system. Autodocs
are function description sections, which are automatically extracted from the source
itself. An entry in the Intuition autodocs (intuition.doc) might be written as “the
BeginRefresh( )autodocs.” A reference to a function description in the Layers library
might be layers.library/BeginUpdate( ) or layers/BeginUpdate( ).

The autodocs appear in volume 2 of the Rom Kernel manual, but the most up-to-date
versions are released on a disk with the developers’ distribution of the system software.

Many technical aspects of Intuition relate closely to the Layers library, which supports
clipping and saving of offscreen areas of windows. It is very useful to understand the
basics of this library, but it should be rarely, if ever, used by an application program
directly.

A word on the multi-tasking nature of Intuition might be helpful. As far as your program
is concerned, Intuition has “two parts” in that Intuition library code may be run on two
schedules: your program (assuming your program has a single task accessing Intuition)
and the Input Device. The latter is a task that runs on the user-interaction schedule as an
input handler (the entry point is called Intuition( )). It appears to your code almost as if
it were running as an interrupt, since it runs at high priority and thus can preempt your
task.

The synchronization of the input schedule and your program, and the arbitration of data

structures shared by your program and the Intuition input handler are the two most
delicate topics which are discussed below.
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2.

SCREENS

Height and Position

In support of PAL displays (which support more lines than their US counterparts), a
method is provided to open screens to their full height on any display. This is done
by specifying the value STDSCREENHEIGHT in the NewScreen.Height field (this
constant is defined in intuition.h).

If you intend to provide your own CUSTOMBITMAP for the screen, you need to
know how big the screen will be before opening it. This is done by examining the
public field GfxBase->NormalDisplayRows. Note that that field specifies the non-
interlaced count (on US machines it is 200).

A new feature: screens of less than full height are not constrained to the bottom
portion of the display. When opened, screens will appear (safely) at the display
position specified in NewScreen. TopEdge. The user can drag short screens up to the
top of the display. The display area at the bottom of the display below the bottom of
a short screen is solid in the background color of the front screen.

At the bottom of the display, beyond NormalDis<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>